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Introduction 

During the first half of January 2018, INGENAES brought together four students from the University of 

Illinois at Urbana-Champaign (UIUC) with nine students and staff from Njala University to learn how to 

plan for and create farmer-to-farmer videos (see Annex 1). The topics of the videos were selected in close 

collaboration with the USAID funded Feed-the-Future Scaling up Aquaculture Production (SAP) project 

implemented by World Fish in Sierra Leone. SAP also provided encompassing support for the actual filming 

in the field. Two trainers from Access Agriculture, Phil Malone and Kevin Mutonga, were brought on 

board to bring their longstanding expertise on how to make and disseminate such participatory videos1. 

High quality “farmer to farmer” training videos in local languages help extension workers and local radio 

stations reach farmers better. Each video is carefully scripted to accuracy and veracity and to facilitate the 

translation of the script into multiple languages while still using the same video footage.  

Objective and Output 

The main aim was to create videos that would be very useful as an extension tool for the SAP project and 

beyond. The secondary objective was to build the capacity of students from different areas of study to 

work together in producing such effective communication and extension tools be able to produce farmer-

farmer videos. While this is an enhancement to the education they are receiving as part of their regular 

degree programs, by engaging Njala University as a partner in this endeavour, the aim was also to build 

the capacity of the institution to produce videos for development as a potentially revenue generating 

activity. Having such improved capacity in the country would facilitate the more widespread use of videos 

by governmental agencies as well as NGO implemented projects.  

Videos on three topics were produced and are now available on AgTube: 

How to use Secchi Disk  

https://www.agtube.org/en/content/how-use-secchi-disk 

Effective Fish Marketing  

https://www.agtube.org/en/content/fish-marketing-plan-better-prices-0 

How to test for pH  

https://www.agtube.org/en/content/testing-ph-fish-pond 

https://www.agtube.org/en/content/testing-ph-fish-pondtemne 

 

Training Overview 

The Njala University students and staff and the UIUC students were grouped in three groups of four to 

five and worked together intensely from January 3 to 14, 2018, with some follow up work done by the 

Njala students and Kevin Mutonga after the UIUC students returned to the United States. 

                                                

1 Phil Malone, who already worked with UIUC in Bangladesh, Sierra Leone, and Liberia as part of the United States 

Agency for International Development (USAID)-funded Modernizing Extension and Advisory Services (MEAS) 

project; and with Kevin Mutonga, who is the Global Translation Officer for Access Agriculture and is an experienced 

practical trainer for both audio and photography. 

https://www.agtube.org/en/content/how-use-secchi-disk
https://www.agtube.org/en/content/fish-marketing-plan-better-prices-0
https://www.agtube.org/en/content/testing-ph-fish-pond
https://www.agtube.org/en/content/testing-ph-fish-pondtemne
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The training was designed to be very practical with the emphasis on good quality research with the 

farmers, development of a detailed script based upon training principles and working out how to show 

the achievements of the farmers through both interviews and practical demonstrations.  

Subjects covered included the following: 

 Why use video?  

 Opportunities to show video programs 

 Elements to use within a video  

 Who is the Audience?  

 What is the Aim or Objective  

 What is the Content?  

 The Production Process  

 Research and Preparation  

 Zooming-in, Zooming-out  

 Scripting 

 Do’s and Don’ts  

 Practical tips  

 Planning for Filming  

 Schedules and Shot Lists  

 Interviewing  

 Video Equipment  

 Filming  

 Logging Shots  

 Selecting Material  

 Rough or First Editing  

 Review of Rough Edit  

 Final Editing  

 Compiling accompanying material   

 

The training was carried out in English, but the actual videos will be made available in local Sierra Leone 

languages such as Mende, Temne, Limba and Krio.  

Throughout the training, Access Agriculture emphasized good communication with the focus on how to 

best reach the farmer and encourage changes to improve his/her profitability.  The concept of “farmer to 

farmer” videos was be demonstrated with many relevant clips.  Participants were reminded of how we 

learn, how training for adults must differ from classroom experiences, and how farmers will always be 

interested in seeing techniques explained by other farmers.  Thus the three teams received hands-on 

supervision and sped up the process of “learning by doing.” 

This report includes a synopsis of the good practices in making Farmer to Farmer videos (See Course 

Content, Annex 3)  as well as a “Guide to Editing with Adobe Premiere Pro CS6 2018” (Annex 5). 

Equipment  

Three cameras supplemented with SD cards, microphones, headphones and tripods were provided by 

UIUC and Access Agriculture.  For editing, three laptop computers with agreed editing software and extra 

hard drives were available. Three zoom microphones and accessories assisted with recording voice overs 

and translations. Some of this equipment was provided to Njala University (see Annex 4) for continued 

use. Upon conclusion of the workshop, participants will be assigned tasks to put the learning into practice. 

In order to fulfil these tasks, the participants will need access to this equipment. Dr. Paul McNamara will 

set up detailed agreements on the use of the equipment with the institutions that are given the 

responsibility of handling the equipment and making it available to the trainees. 

Distribution Options 

Potential distribution methods are by DVD, preloaded mobile devices and smart projectors, that can be 

operated from a mobile device. The videos can be used by extension services working with farmers groups 

in different parts of the country. This will be an invaluable tool as farmers learn step-by-step by watching 

the videos and by listening to extracts on local FM radio stations.  As everything is recorded digitally to 

broadcast standards, the final programs are very suitable for broadcasting on TV stations. 



 

5 | P a g e  

Day to Day Schedule and Activities 

January 2nd 2018 

In the evening, we met with Adolphus Johnson and some of the Njala students for a brief introduction to 

what would be covered on the following day. 

January 3rd 2018 

We started the training at 9am with introductions, expectation setting of the course. 

We took them through questions, why do we use videos and where do we use videos? Which later led 

the discussion of how can it be applied into the agriculture context. 

Dr. McNamara and the UIUC students came in late because of some unavoidable circumstances, and 

quickly we brought them into speed of the progress. 

With the guidance of the video production dos and don’ts, we took them through the production process. 

January 4th 2018 

We started a little late because of some communication problem on transport, and found the students 

reviewing some of the Access Agriculture videos. 

We did a recap of the previous day, and then started on the grammar of video production and some 

illustrations. 

The students looked at some examples of scripts that we had, then we guided them through the grammar 

of script writing and the dos and don’ts of script writing. The students were divided into groups of four 

and assigned topics in which they were to write scripts for the following situations: 

1. Making a cup of tea 

2. Fetching water from the stream 

3. Negotiating motorcycle taxi price 

The exercise took 15 minutes and then the scripts were given to a different team to read out while we 

were acting what they read out. 

We had a feedback process which the following needs were raised: 

 Proper planning of the shots 

 Consistency of the shots 

 Shorter sentences 

 Matching words with action 

 Conversational language 

We took them through the good case practices in interviewing, the do’s and don’ts in an interview. 

The UIUC team had come with three camcorders, which were to be used in the course for filming. The 

students were taken through the different components in the camera bag, how to use the tripod effectively 

and how to operate the video camera. With the same groups they each took the equipment and went to 

interview each other. 

After 20 minutes they came back and we reviewed the footage of each team. The following came up: 

 Some didn’t frame the shots properly 

 Some had to try different takes to get a good one 

 Some used actions while others didn’t  
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 Some looked at the camera instead of the interviewer 

Colby Silvert2 later joined the team; he is the project leader in fish farming with World Fish at Makeni. 

The students were taken through the need for a checklist to ensure everything is okay before heading to 

film. Based on the different skills, students were divided into different teams for the production of the 

videos. 

Colby introduced the project, the distances and where the filming will take place, and took them through 

what the three different topics entailed: 

1. Use of Secchi disk 

2. Use of the pH Kit  

3. Marketing of fish 

He took us through a presentation which had pictures of the Secchi and the pH kit and the particular fish 

in question – tilapia. 

Based on random selection, the teams were assigned the different topics: 

1. Group 1 - use of pH kit  

2. Group 2 - use of the Secchi disk  

3. Group 3 - marketing team 

Final arrangements were made on the transport from Njala university to Makeni on the northern part of 

the country. 

January 5th 2018 

The journey started at 7.30 am and we arrived at 12:00 noon. 

One team headed to the WorldFish offices and switched cars to use the WorldFish car since the other 

was a taxi. 

After the lunch break, we headed to Tonkolili district - 60km away from Makeni - where the WorldFish 

ponds were at Makali. 

Colby introduced his team at the ponds and others introduced themselves, then we were taken through 

the fishpond process, from fingerlings collection to breeding and harvesting. 

Later, the filming groups were taken to different farmer groups who would guide in the different topics 

and plan for the filming. 

At 1700hrs we head back to Makeni; in the evening the students met in a restaurant where they started 

writing the scripts before dinner and planned how to organise the filming for the next day. 

January 6th 2018 

The first group to start filming was the pH group.  They took a while to get started but made some very 

good progress with the interviews and were helped by the protection of trees, which provided shade and 

kept everybody cool.  They managed to get the filming done efficiently and shared the jobs among the 

team.  After carrying out the filming, other videos about fish farming were shown in the community storage 

area, using the smart projector. The fish farmers really appreciated the other videos and the videos 

sparked other questions and a lively discussion. 

                                                

2 Colby Silvert is the in-country Extension Specialist working for UIUC/INGENAS as well as the Project 

Extension Coordinator for WorldFish and is based in Makeni, Sierra Leone 
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The other group who started filming were the marketing group. They experienced some problems with 

traffic noise for their interviews and needed assistance in keeping the shots steady, allowing the action to 

happen and keeping the camera still on the tripod.  

With this community, at Mathele Bana we also showed the other fish farming videos with the same effect 

of stimulating discussion. 

The group working on the Secchi disc had spent the morning finalizing their script. They had some issues 

deciding how best to conduct the interviews, but in the end found places for the interviewer to be 

comfortable.  For the filming, they had to find ways to cover the shots with enough variety.  They realised 

that in order to show the disc entering the water and how to use it accurately, one of the team would 

have to go into the water with the fish farmer.  This they did despite some initial doubts. 

Later in the evening, there was a social event with drumming and dancing provided by the Makali Women’s 

Group. 

January 7th 2018 

Location: Makali Agricultural Training Center 

We started by reviewing some of the footage, and the marketing team had a lot of movement in their 

tripod. They had only few usable shots, but the interviews were well shot. 

The other teams saw the need to have other additional shots because of some of the errors they had in 

their footage. 

The marketing team accompanied with Kevin went to the fishponds to get shots of the fishponds and the 

different sizes of fish. 

January 8th 2018 

Location: Makeni to Magbafth, Mile 91 market and Bo at Njala University  

We went to Magbafth, where there are other fish farmers led by Mohamed Kanu of World Fish; we had 

introductions and told the farmers of the goal we were to achieve. 

The Secchi and pH teams took time to do more filming of the fishponds while the marketing team 

interviewed one of the farmers. 

After meeting the farmers, we went to the market in Mile 91 to film in the market, though there was very 

little space. 

Meanwhile, other groups took footage of different street and market scenes. 

We later went to the restaurant where the farmers sell their fish and the students did more filming. 

After lunch, we departed to Njala University but left Colby to later meet in Njala university during the 

symposium. 

The main translator from Temne to English was Binta from World Fish. She accompanied the team to 

Njala to help in the translation of the interviews. 

January 9th 2018 

Started at 9. Recap of the filming days. What had the teams learned? 

Since there was only one computer dedicated for editing we had to improvise by having 2 laptops from 

the students then installed the premiere pro editing software. (since Adobe no longer have standalone 

software rather they have monthly subscriptions so we had to use Kevin’s account to install). 
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Installation took time because of the unstable internet in the campus. 

For this part the student’s worked with the Premiere Pro CS6 manual which Access Agriculture has 

compiled. 

The teams started on the editing capture of the footage and worked on the placing the folders. Having 

different folders to work with premier pro editing software. 

We were later joined with 2 Temne speakers who were to help in the translations of the interviews. 

After tea break the students were taken through the premier pro software and they soon started doing 

the import and logging of the clips. 

After lunch break the teams continued with the translations of the interviews and further editing of the 

script to be ready for the voicing, main emphasis been the understanding of dealing with the phonetic 

language and having an accurate translation from Temne to English. 

Before the end of the day, the teams were given assignments on setting up the zoom recorder settings 

with reference to the manual. 

January 10th 2018 

Raymond Vuol from Countrywise Communication, Ghana joined the team to help in the editing process. 

Teams started to finalize the script and as as soon as each finished they took turns in recording since they 

were using  the same venue for recording. 

The team that finished was taken through how to handle the audio files and how to ingest in the software 

and log them. 

January 11th 2018  

The teams continued in the editing of the programs, recording the voice again since there were some 

changes in the script. 

There was an issue with one team where the files the recorded got lost due to a virus in their editing 

machine, but it was soon sorted. 

Some clips turned green and froze in the timeline while editing but after they were changed to mp4 format 

and they worked. 

Two teams placed the pictures on the timeline while the other worked on the interviews before placing 

the files. 

After lunch break  

The teams pushed to have the programs finished but at the end of the day all teams had an average of 45% 

done and we played what they had done and had a feedback and last speech session before finishing for 

the day.  

The students were given different suggestions of free editing software to continue practicing. 

January 12th 2018 

The UIUC students went back to Freetown ready to head back to the US. 

Njala students continued with the translations of the script to Temne and later the groups voiced and 

renamed the files. 

The programs were to be completed over the weekend with the Access Agriculture team so that they 

could be used for the symposium. 
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January 15th 2018  

The Symposium started with the beginning of the breakaway sessions. 

We were in one breakaway room where we were able to introduce the process of producing a farmer-

to-farmer video. 

Power went off but because we had the smart projector, we continued. This made people interested in 

the idea.  The students from Njala University were active participants in the session and shared their 

experiences from the past ten days. 

Again, the basis of the session was the Do’s and Don’ts booklet from Access Agriculture. 

The different topics we discussed in regards to production were met with much appreciation and 

interaction and some of the points brought up in questions were: 

 How much was the smart projector kit? 

 How can Liberia benefit from such a course? 

 How should we approach farmers in the use of videos? 

 How can we get the videos to the farmers currently? 

January 16th 2018 

We met with the Njala students and did some final edits on their videos and had the Temne language 

versions ready for viewing on the afternoon. 

All the videos were ready in both languages except the Secchi disk one in Temne, which was to be finished 

in a week’s time. 

After lunch the videos were shown.  There was great excitement and praise for the quality of the videos 

produced by the students in such a short time, and to the surprise of many, what their students could do 

in a short time. 

Main Conclusions 

There was a very good response from both sets of students and they worked very well together.  Initially 

there was not an appreciation of the need to carry out detailed research with the communities. However, 

this soon became clear when the teams realised that the finished programs have to be training focused in 

the “farmer-to-farmer” style. 

It is vitally important to have a dialogue with farmers and show them other videos so that they can see 

how other farmers can help them and vice versa.  This reduces the demands for cash payments for assisting 

with filming.   

Normally the training would have been carried out over a 14-day period, but the students did assist each 

other and show that they could put the theory into practice quite quickly. Nonetheless, it is important 

that a mentor be on hand for each group to avoid basic mistakes that result in the need to reshoot.   

It is important that the Njala team, including the five students doing agricultural communication courses, 

are encouraged to work together and that their work is judged based on scripts, descriptions of the 

processes, and the final videos.  At least one new camera should be obtained by Njala University and 

continued liaison with Access Agriculture to receive advice on scripts, translations and editing. 

The formation of the INGENAES video What’sApp group really helped with team communication. 
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Annex 1: List of Trainees in Each Group 

 

Secchi Disk Group  

https://www.agtube.org/en/content/how-use-secchi-disk 

Tamba Darlington  Male Njala University Radio (staff) tambaderlington494@gmail.com  

Sesay Christiana Female Agricultural Communication 

and Media 

christianasesay3@gmail.com  

Scott Christian Male Agricultural Communication 

and Media 

criscott22346@gmail.com  

Mejia Nayeli Female Global Studies: Global Health 

(UIUC) 

nmejia4@illinois.edu  

pH Group 

https://www.agtube.org/en/content/testing-ph-fish-pond 

https://www.agtube.org/en/content/testing-ph-fish-pondtemne 

Name Surname Sex Field of Study Email Address 

Sankoh Sunkarie Female Agriculture General sunkarysank1386@gmail.com  

Bundu Ishmail Bai Male Agricultural Communication 

and Media 

baibunducarrick@gmail.com  

Sessie Tamba Male Agriculture Extension 198817593t@gmail.com  

Zhu Mengyuan Female Agricultural and Consumer 

Economics – Financial Planning 
(UIUC) 

mzhu29@illinois.edu  

Marketing Group 

https://www.agtube.org/en/content/fish-marketing-plan-better-prices-0 

Shaw Alhaji Male Agricultural Communication 

and Media 

shawlaji@gmail.com  

Kabba Mohamed 
Abdulai 

Male Agricultural Communication 
and Media 

 mohamedakabbajr1@gmail.com 

Momoh Daniel 

Nyuma 

Male Agriculture General danielnyuma791@gmail.com  

Deng Una Female Agricultural and Consumer 

Economics – Financial Planning 
(UIUC) 

kdeng8@illinois.edu  

Laumann William 

Matthew 

Male Agribusiness, Markets and 

Management (UIUC) 

laumann2@illinois.edu  

  

https://www.agtube.org/en/content/how-use-secchi-disk
mailto:tambaderlington494@gmail.com
mailto:christianasesay3@gmail.com
mailto:criscott22346@gmail.com
mailto:nmejia4@illinois.edu
https://www.agtube.org/en/content/testing-ph-fish-pond
https://www.agtube.org/en/content/testing-ph-fish-pondtemne
mailto:sunkarysank1386@gmail.com
mailto:baibunducarrick@gmail.com
mailto:198817593t@gmail.com
mailto:mzhu29@illinois.edu
https://www.agtube.org/en/content/fish-marketing-plan-better-prices-0
mailto:shawlaji@gmail.com
mailto:danielnyuma791@gmail.com
mailto:kdeng8@illinois.edu
mailto:laumann2@illinois.edu
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Annex 2: Photographs of Trainees in Action 
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Day One of the symposium 

 

Students describing making the videos at the symposium 
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Annex 3: Course Manual 

Video Production Do’s and Don’ts 

Why use video? 

1. For documentation and as a future resource (time shifting) 

2. To give particular messages 

3. To target particular groups of people or allow all groups to watch 

4. It has wide acceptance and is popular to watch 

5. It has high credibility for the viewers and can build trust 

6. It can easily be duplicated and spread to other areas 

7. It is cost effective (a well-researched, well-written and well-made video will have a long lifetime) 

8. It can be translated into other languages 

9. It is not necessary to be literate in order to learn from video 

10. It can provide motivation and encouragement (farmers will pay most attention to what other 

farmers say) 

a. Use interviews 

i. with innovators to inspire (farmer peer trainers) 

ii. with subject specialists for particular knowledge 

11. It is easy to learn from – the viewer both sees and hears information. This can be enhanced by 

providing practical exercises to do after watching the video 

12. It can stimulate new practices and demand for new support 

13. It can be used to disseminate important information 

14. The learning experience is the same every time 

15. The same video can be used with many types of target audience, although you may change the 

style of language in the voiceover 

16. It can be used to remind people of good practices before certain times of the year, e.g. dipping, 

harvest, sowing 

17. It can help farmers understand the ‘why’ behind new practices 

18. It has lasting impact – because people both see and hear information, it is easier to recall this later 

BUT ALWAYS ASK YOURSELF . . .Is the subject matter VISUAL? 

The Production Process 

Think how you will multiply and distribute the video 

Pre-Filming ◗ Initial Research / Baseline Survey 

◗ Script ideas 

◗ Research 

– desk research 

– field research 

◗ First draft of script 

◗ Discuss with colleagues and end-users 

◗ RECCE Visits (location scouting): 

Where can you film? Which farmers? 

What new information can the farmers tell you? 
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◗ Redraft script (maybe many times!) 

◗ Prepare for filming: 

– Write questions for interviews 

– Prepare shot list 

– Shooting schedule 

– Liaise with people you are filming with 

Filming ◗ Input footage and logging 

◗ Select and transcribe interviews 

◗ Decide if you need other interviews or shots 

◗ Redraft script 

◗ Record voice over 

Initial Edit ◗ First (rough) edit 

◗ Assessment of video with a test audience 

◗ Now make further changes to script, pictures and programme 

Final Edit ◗ Add captions, music etc. (make sure audio levels are correct) 

◗ Prepare any other material that you want to use with the video 

(e.g. leaflets, experiment or practical skill) 

◗ Multiply and distribute the video 

Scriptwriting 

1. First, always consider the target group 

2. Explore all potential sources of information, including knowledge from farmers and field workers 

3. Consider the final product and how the video will be watched 

4. Each video module has to stand on its own, without explicit reference to other modules 

5. Reflect and exchange on major content of script with staff of farmer field schools and the target 

group 

6. Exchange the script with subject matter specialists and colleagues 

7. Make sure there are no factual errors 

8. Modify the script after having visited the field and conducted exploratory farmer interviews 

9. Simplify and reduce the words and phrases 

10. Practice, practice and practice, as you learn by doing three sections of a script 

INTRODUCTION 

 tell the audience what you are going to teach/show them 

THE MAIN BODY OF THE SCRIPT 

 tell them the information 

CONCLUSION 

 tell them what you have told them 

 Keep it simple! 
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Scriptwriting Do’s and Don’ts 

◗ Start by presenting the broader context 

◗ Don’t use difficult words 

◗ Avoid complicated words ◗ Don’t use acronyms 

◗ Use short phrases ◗ Don’t write in the third person 

◗ Write for the spoken word ◗ Don’t use names of organisations or projects 

◗ Keep the subject interesting ◗ Don’t use long lists 

◗ Follow a logic sequence ◗ Don’t introduce examples that are not feasible or do not inspire 

◗ Invite the target group to test the ideas presented 

◗ Don’t introduce a lot of numbers and calculations 

◗ Finalise the Audio column before putting in pictures in the Video column 

◗ Don’t put words between brackets 

READ the script to your colleagues, and to farmers 

Do the words ‘flow’ when they are spoken aloud? 

In a video, the viewer cannot easily refer back to something they have heard, so the programme must 

make sense as you hear the words 

Interviews 

1. Interviews normally explore the opinion and/or experience of the interviewee 

2. Make sure that interviewees are relaxed 

3. Choose a good background behind the interviewee (no major distractions; different colour from 

the colour of the interviewee’s clothes) 

4. Try to keep the number of people standing around to a minimum and also keep any other 

distractions to a minimum 

5. The questions are not used in the editing, they should be OPEN QUESTIONS: who, what, why, 

when, where and how 

6. The answers should be complete sentences, this will make editing easier 

7. It is important that the answers are listened to carefully, as it is often necessary to ask for more 

explanation from the interviewee 

8. It is the producer’s job to make sure that there are enough cut-away shots to illustrate what the 

interviewee is saying 

9. It is very important that the name and official title/status of the interviewee be collected together 

with contact details. This is so that name captions can be prepared or that a ‘thank you’ caption 

at the end of the programme is correct 

10. It is always better to have one person asking the questions and someone else operating the camera 

Interview Do’s 

◗ Plan your questions before the interview 

◗ Ensure the microphone works BEFORE you go to film 

◗ Remember the microphone and extra batteries 

◗ Use OPEN questions  
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◗ Put the microphone recording to MANUAL and check your sound level 

◗ Listen on headphones 

◗ Ask the interviewee to talk to and respond only to the interviewer 

◗ Frame the interviewee to allow for ‘breathing space’ 

◗ Position the camera on the same eye-line as the interviewee and interviewer 

How to cope with interviews that need translating during filming 

◗ When answers (and questions) have to be translated during the interviews, remember that this will 

take extra time 

◗ One option is to have a small audio recorder with the person translating, so that either just the 

translator or both interviewee and translator can be recorded 

◗ This audio recording can then be used for transcribing. Many mobile phones now have this recording 

facility 

Tips on using digital video equipment 

Digital cameras, although small, the quality of the material recorded rests in your hands. 

Read the manual and get to know your camera! 

A checklist is vital, the essential items are: 

1. camera  

2. batteries 

3. tapes or memory cards  

4. interview microphone (and batteries) 

5. tripod  

6. headphones 

◗ If you want to do interviews you will need to use a clip microphone, try to hide the cable 

◗ Remember to switch to MANUAL audio mode, if you can 

◗ Don’t forget the headphones – to ensure you are recording sound 

◗ Try to always keep batteries charged and everything together in the camera bag 

And now for action …. 

◗ load the battery 

◗ turn on the camera 

◗ remember to allow some seconds recording before the action you want to film, and also some seconds 

at the end 

◗ Remember to save battery power by turning off the camera if you are not using the camera for a while 

and closing the LCD screen when possible 

◗ In the viewfinder you can see how many minutes of battery life are left 

◗ Make sure all batteries are charged! 

◗ Always use the tripod for best results 
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◗ Tripods give stability and an easy way to know that the picture is level by using the ‘bubble’ indicator 

(the spirit level) 

◗ There is a ‘plate’ which attaches to the camera and allows the camera to be quickly attached and 

detached from the tripod 

Filming 

1. The cameraman dictates when action starts and stops, to ensure the camera is recording before 

the action happens 

2. For activity shots, if there is the time you may need to ask the farmer or other person to do an 

action two or three times so that you can get different angles, but always be aware that people 

may have busy schedules 

3. The main rules for activity shots are to try and get a wide shot, close ups of action and a face shot 

4. Everyone must be checking for continuity and that things are said and done correctly 

5. DO NOT leave the camera on the tripod unattended, it can easily get knocked over 

6. Always wear headphones for good sound recording. Listen for sound in the background, stop 

people in the background talking or using mobile phones when filming – ask them politely to be 

quiet! 

7. Be careful of light reflecting off very bright surfaces (e.g. white shirts, flipchart sheets or even tin 

roofs) into the camera, especially at midday 

8. What you see in the viewfinder is what you record! This also applies for audio 

9. Don’t go out filming without an advanced script - and prepare your shot list before filming to 

make sure you get all the shots you need 

10. Practice, practice, practice… you learn and become confident by using the equipment. The camera 

is your friend; do not be afraid of it! 

Remember…if the sun is hot, the best time for filming is early morning and late afternoon. 

Filming Do’s and Don’ts 

◗ Check the equipment is working BEFORE you leave 

◗ Don’t forget to take all the equipment … who is responsible? 

◗ Check you have reformatted any memory cards, and have spare ones with you 

◗ Don’t forget to charge the batteries 

◗ Use a tripod! ◗ Don’t wander aimlessly with the camera 

◗ Film action from different positions with different shot sizes 

◗ Don’t take only one shot of an action 

◗ Explain beforehand why an action will need to be repeated 

◗ Avoid filming in the middle of the day, the pictures are likely to appear ‘burnt out’ 

◗ Frame the pictures before pressing record, remember the rule of thirds 

◗ Don’t start filming a sequence if the tape is nearly finished 

◗ Let the action happen in front of the camera 

◗ Don’t forget to check the format you are recording 

◗ Transfer and backup footage regularly 
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The Editing Process 

1. Transfer footage into the computer 

2. Remove the SD card from the camera and insert into the card reader of the computer 

3. Create a folder in your PROJECT FOOTAGE folder for that days filming, copy the files into that 

folder 

4. It is good practice for fi les from each day (or half day) to be copied into a separate folders 

5. Ensure you make a copy of this folder on an external drive  

6. Open your editing project 

7. Import the footage 

8. If you can, log the clips 

9. Put descriptions for each shot – ensure you write in the description column and that you are not 

accidently changing the filename 

10. Be critical of what has been filmed… how can you improve? 

11. Delete shots which are of no use at all, do not delete something that COULD be used 

12. If your software allows, create sub bins and put groups of relevant shots in these bins, this will 

make editing faster 

13. Select Interview answers 

14. Create a sequence for each person interviewed 

15. Put on the sequence all the answers the person gave 

16. Export each interview sequence in a suitable format 

17. Transcribe each interview (word for word) – and translate if necessary 

18. Select the sections for interview for your video and put those words in your script 

Voice Over  

1. Record and transfer the voice files, make sure you rename the files before importing them into 

your edit 

2. Create a sequence for your main edit 

3. Space the voice as necessary 

4. Insert Interviews 

5. Place the sections of interview you want to use in position on your sequence 

6. Now you can start editing! 

7. Place your cutaway pictures and sound 

8. Use another video track for captions 

Editing Do’s and Don’ts 

◗ Create a folder for each camera card you are transferring 

◗ Don’t have a pan or zoom followed by another pan or zoom, it does not make a good programme 

◗ If your software allows, write a description for each shot that you can use 

◗ Don’t rush when you are deleting unusable clips from the bins, or you will make mistakes 

◗ Always backup your project   

◗ Practice, practice and practice, you only learn editing by doing it
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Annex 4: Equipment handed over to Njala University 
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Annex 5: Editing Guide 
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THE EDITING SYSTEM 
 

Editing Software: Adobe Premiere Pro CS6 
   C:\programme files\adobe\premiere 
 

Premiere Pro CS6 can open projects from earlier versions of Premiere,  
a CS6 project should open in CS5 version of Premiere,  

but you cannot save a CS6 project as an earlier version. 
    
The HELP MANUAL can be accessed in the program at: 

HELP > ADOBE PREMIERE PRO HELP 
USE IT! Here you can find out very useful information. 
If you are connected to the internet you will be able to access further information from 

here. 
 

BEFORE STARTING A NEW PROJECT 
 

 Your working drive for Premiere Pro files is best on the internal D drive (or E drive 
depening on your computer). 

 Use an external drive for backing up your complete project. 

 Create a folder for ‘Premiere Project Editing’ if it does not already exist. 

 Premiere Pro needs enough space on the C drive to work efficiently so avoid putting 
too many other programs on the computer. 

 It is sensible at the end of a project (and at the end of each day) to back up your 
Project folder containing ALL your working files. 

 These archive backups can be used to re-create a project if your computer 
crashes. 

 Use a separate hard drive to create archives of your camera footage. 
 

IF YOU ARE TRANSFERRING FROM VIDEOTAPES…  
 

 Do you need the camera attached (and switched on)?  
Either because you need to input footage or because you need to output the finished 
programme onto videotape. 

 It is better to power the camera from mains when you are editing, preferably plugged 
into a UPS to prevent variations in power supply from affecting the computer. 

 Connect the camera to the computer (before going into Premiere) using the four pin 
firewire cable. Ensure the camera is in playback mode. 

 The computer will recognise the camera and you can control the tape from the 
computer. 
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WHEN YOU START PREMIERE PRO  
 

If this is a new project double click on the Adobe Premiere Icon on the desktop, select 
‘new project’ from the opening screen.  
 

In the NEW PROJECT SCREEN there are 2 tabs: General and Scratch Disks 
At the bottom of the screen there is information for the location and name of the project. 
At LOCATION: select the folder Premiere Editing and create a folder for the whole 
PROJECT. 
At NAME: give a name to the project (usually the same as the project folder). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the GENERAL tab:  

 For LOCATION: browse and select the 
Premiere Editing folder on the D (or E) 
drive, and create in this a working folder 
for your PROJECT (the name of the 
project). 

 For NAME: Type the name of the 
project and select the location of the 
working folder that you created.  

 Ensure Video, Audio and Capture tabs 
are correctly selected. 
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These settings can also be accessed within the Premiere screen by going to: 
Project > Project Settings 
 
 
When you click OK the screen goes through to the NEW SEQUENCE options window. 
 
In the NEW SEQUENCE SCREEN there are 3 tabs:  
Sequence Presets, General and Tracks 
 

In the SCRATCH DISKS tab:  

 For Captured Video, select the project 
folder you created and then within this, 
make a new folder called FOOTAGE. 

 For Captured Audio select the 
FOOTAGE folder you have just 
created. 

 For Video Preview, select the project 
folder you created and then within this, 
make a new folder called PREVIEWS. 

 For Audio Previews select the 
PREVIEWS folder you have just 
created. 
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In the SEQUENCE PRESETS tab:  

 Select the correct sequence  
format :        

 For SD AVI footage files use 
DV-PAL Widescreen 48Khz 
(or Standard 48Khz if you are 
working in a standard 4:3 
format) 

 

 

In the GENERAL tab:  

 Ensure the settings are 
correct for working with PAL 
(25 frames/second) 

 

 

 
In the TRACKS tab:  

 Select how many 
video and audio 
tracks you want in 
your sequences  

 As standard there 
are 3 Video and 3 
Stereo Audio, you 
can always add 
more to a 
sequence later. 
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When you click on OK, the screen 
will open up in Premiere 

 
 
 
 

N.B. 
 
If you are opening an existing 
project go to the project working 
folder on whichever drive you are 
using and double click the 
Premiere Project Icon for that 
project. 
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PREMIERE SCREEN LAYOUT (Editing CS6) 
 
 
 
 
      Source Viewer        Program Viewer 
 
 
 
 

 
 
            
            Audio 
Levels 
Project Window 
 

Effects Window                   Sequence Window (for the editing)                 
 
                                         Toolbox (this may appear in different positions) 
If the Project window (bottom left) is not visible, select it. 
The name of the other windows are: Media Browser, Info, Effects, Markers and History 
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PREMIERE SCREEN LAYOUT (Editing CS5.5) 
 
 
 
 
      Project Window               Source Viewer     Program Viewer 
 
 
 

 
 
 
 
 
            
            Audio 
Levels 
 
Effects Window                      Sequence Window (for the editing)                 
 

Toolbox (this may appear in different positions) 
 
If the Project window (top left) is not visible, select it. 
The name of the other window in this area is: Resource Central 
 
If the Effects Window (bottom left) is not visible, select it. 
The other windows in this area area: Media Browser, Information and History 
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Once the Premiere programme is open, it is sensible to always  
check the following settings: 

       
Edit > Preferences > Autosave 

- It is sensible to Autosave a project every 5 or minutes (you 
can do a lot of work in 5 minutes!) 

- maximum 15 or 20 saves  
 
 

Edit > Preferences > Media 
- Media Cache : 

Tick: Save next to originals if possible 
Create a file on Drive D for Premiere Media Cache 

- Create a file on Drive D for Premiere Media Cache Database 
- ‘Clean’ from time to time the Media Cache Database, 

particularly when you start a new project, or if you have 
problems during the edit.  
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AFTER OPENING A NEW PROJECT IN PREMIERE  

 

 Sort the positioning of the different information columns in the PROJECT 
SCREEN if necessary (they can be dragged across), a sensible layout is shown 
below. 

 
 

 Now create a bin (right click 
in the project area and 
select NEW BIN) and label 
the bin. 

 Create bins in the Project 
so that you can separate 
the different items e.g. 
Footage Voice Over, 
Interviews, Sequences, 
Captions, Music etc. 

 Bins can be opened and 
closed using the small 
triangle. 

 
 

 
 
 
 
TO IMPORT FOOTAGE FROM VIDEOCARDS 
 

 Change your workspace layout to Metalogging 
Window > Workspace > Metalogging 

 On some computers you may be able to select the metalogging workspace from 
an option top right of the Premiere screen 
 

 In the Project Window select the footage bin, right click and select IMPORT 

 Browse and find the folder where you transferred the video files to 

 Select this folder, and then click on IMPORT FOLDER 

 The folder (as a bin), and all the files, will now be in the footage bin, the name of 
the folder will be the name of the bin 

 If you did not select the footage bin before importing, you can move the new bin 
to the footage bin 

 It is sensible to have a separate folder for each day’s filming 

 The clips now need to be logged: see page 15 
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IF YOU ARE CAPTURING FROM VIDEOTAPE 

 
Once the Premiere programme is open, always check the following settings: 
 
Edit > Preferences > Capture 

- Normally tick the top 3 options on this screen 
- If you know you have a problem with dropped frames 

on the footage, then untick the option for abort capture 
on dropped frames, but realise that this will create a 
problem with editing 

Edit > Preferences > Device Control 
- Devices: set for DV/HDV Device Control 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Go to OPTIONS:  

 Video Standard : make sure you 
have the correct video system 
(PAL) this is VERY important as it 
will affect the controls when you are 
capturing footage. 
 

 Device Brand : Select the brand 
name of your equipment.   
 

 Device type: set to standard. 
 

 Timecode Format : 
Non drop frame  
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TO CAPTURE FOOTAGE FROM VIDEOTAPE 
 

 Open your Capture Window (File > Capture, or use the key F5). 

 The Capture Window allows you to monitor the incoming video. 

 You can use the controls below the screen to control the videotape in the 
camera. 
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In the LOGGING tab area check: 

 

 SETUP:   
Capture:       Audio and Video 

Log clips to: Select the correct bin 

 CLIP DATA:   
Tape Name:  Insert the Tape name  

Clip Name:    Use the Tape name  

  CAPTURE:     SCENE DETECT 

In the SETTINGS tab area check: 

 

 CAPTURE LOCATIONS: ensure 
Video and Audio is set to the correct 
tape folder in the FOOTAGE and 
PROJECT folder 

 Use BROWSE and create a new 

folder for each tape 
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 Go back to the LOGGING tab. 

 Ensure the correct videotape is in the camera - and rewind it. 

 Play the videotape for a few seconds so you are certain you have picture, sound 
and timecode being captured. 

 Now in the CAPTURE section of the screen, click on TAPE. 

 The tape will be input into Premiere. As SCENE DETECTION is on, wherever the 
tape has been paused or stopped, a new clip will be created.  
N.B. Scene detection will ONLY work if the date and time have been set in the 
camera 

 

 While the tape is being captured the STATUS AREA at the top of the Capture 
Window will show details of the current capture (Clip Name, Capture Duration, 
Remaining Disk Space). 

 If you do not see this detail changing then stop the capture as you probably have 
forgotten to select SCENE DETECT. 
 

 When the tape gets to the end of the timecode (either the end of tape, or if there 
is a break in the timecode on the tape) it will stop capturing. 

 If it is because the timecode has ended, a window opens with the message:  
Capture stopped because blank tape was detected 

 If you do not see this message, click somewhere else on the Premiere screen 
and the message will reappear, or use ALT+Tab key to reveal this window. 

 Click OK to the message. 
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 If you have recorded more footage on the same tape and you now want to input 
the new material, enter the tape number with ‘B’ after the number, and the 
same with the clip number, make sure you are capturing TO THE CORECT 
FOOTAGE FOLDER and to the CORRECT BIN. 

- Line the tape up at the point from where you want to capture 
- Make sure SCENE DETECTION is selected 
- Then select TAPE for capture 

 

THE WORKING WINDOW LAYOUT FOR LOGGING  
 

 Select the METALOGGING layout. 
Go to:  WINDOW > WORKSPACE > METALOGGING 

 On some computers you may be able to select the metalogging workspace from 
an option top right of the Premiere screen 

 Open up a bin to log the footage. 
 

 
 

 For each clip, double click on the icon to open the footage in the viewer, look at 
the clip – you can use the scroll line to view quickly (or use the J, K and L keys). 

 Decide on your description (use LS, MS, CU etc to describe the size of the shot) 
and then type in a description for any clips that are usable – this does not mean 
you will use them, but that they are usable…. 

 Tick if the clip is good. 
 If the clip is no good or is not going to be used, leave the description blank or 

write NG (no good) or NVG (not very good).  
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 After you have put a description for each usable clip, you can delete clips that are 
not needed. 

 To delete only from Premiere, then simply select the clip icon and click DELETE. 
 

 If you want to delete the clip completely from the computer: 

- Select the clip, check it is definitely to be deleted! 
- Right click and select:  Make Offline 
- Now select the option for DELETE the media from the computer 
- Click OK, and on the next screen click OK again 
- Now go to the bin (notice the icon by the clip name has now changed) and 

delete the clip from the bin by using the DELETE key, or the BACKSPACE 
DELETE key. 
 
 
 

 
 

 When all the clips have a 
description, create SUB BINS within 
the Filming Day Bin for different 
subject matters or topics. 

 

 Move relevant clips into these bins 
by selecting the clips and then 
dragging and dropping. 
 

 Alternatively double click the new 
sub-bin icon to open it in a separate 
window and then move the clips 
across into that open window. 
 

 The aim is to not have too many 
clips in one bin as it will be easier to 
find the clips to use for the edit. 

 



 

39 | P a g e  

THE WORKING WINDOWS FOR EDITING 
 

THE SOURCE VIEWER 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 You can select IN and OUT points using  and  buttons (or I and O keys).  

 You have IN and OUT points set, the numbers on the right in white show the 
DURATION. 

 You can play between these clips using LOOP – this option is available in settings 

 . 

 You can delete an IN or OUT point by right clicking in the scroll bar and selecting  

CLEAR CLIP MARKER > IN AND OUT, or IN or OUT  

 You can go directly to the IN POINT using this key  and directly to the OUT 

POINT using this key . 

 You can MARK points on the source clip using this button . You can GO DIRECT 
to these points using the GO TO option available when you right click in the scroll 
bar. 

 The clip can be placed on the timeline by using the OVERLAY  or INSERT  
buttons (bottom right beneath the source window), or by dragging and dropping 
the clip from the source window onto the timeline. The shortcut key for OVERLAY is 
the fullstop key; the shortcut key for INSERT is the semi-colon key. 

 If you are dragging and dropping and you only want to use the VIDEO from the clip, 

drag the video icon    from just below the picture.  

 In the Project Window, open a 
bin and double click on a clip 
to open it in the Source 
Viewer. 

 You can use the YELLOW 
SCROLLER to quickly move 
through the video in the clip. 

 The numbers on the left in 
yellow show the TIMECODE 
at the scroller position (the 
yellow tab). 
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 If you only want to use the AUDIO, drag the audio icon  from just below the 
picture.  

 OVERLAY will cover up whatever is on the tracks which have been selected at the 
editing or IN POINT. 

 INSERT will move the pictures and sound to the right of the editing point further up 
the timeline (unless the tracks have been locked). 

 
THE PROGRAM VIEWER 
 

 
 

 The Program Viewer shows the image from the Sequence (wherever the yellow 
cursor is located). 

 The controls for the Program Viewer are the same as for the Source Viewer. 
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THE SEQUENCE WINDOW  
 
To create a new sequence 

 Select the Timeline bin 

 Go to:  FILE > NEW > SEQUENCE 

 You can also create a new sequence by clicking the ‘new item’ icon on the 
bottom of the project window and selecting SEQUENCE.  

 Select the DV Widescreen 48Khz sequence (or whatever format is suitable for 
your footage) and give the sequence a name (it can also be renamed at any 
point). 

 Now click OK, the new sequence will be created in your Sequence bin and will 
open automatically in the Sequence Window. 

 

 You can DUPLICATE a sequence by right clicking on the sequence name in the 
Sequence Bin, then select DUPLICATE.  

 The sequence will be duplicated in the Sequence Bin with the word COPY beside 
the name.  

 RENAME this duplicated sequence (sequences can be renamed at any time). 

 This is useful when working on a new version of the edit or creating different 
language versions. 

 

 Open a sequence in the Sequence Window by double clicking on the icon in the bin. 

 Sequences can be closed by clicking the small cross beside the name.  

 
 

 
 

 The Sequence Window is where the clips are assembled to create the programme. 

 More tracks can be added by right clicking in the track name area of this window. 

 The tracks can be expanded by clicking on the small triangular arrow by the track 
name.  

 The tracks can be RENAMED by right clicking where the name is on the track and 
selecting RENAME. 
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 You make the tracks ACTIVE for editing by clicking near the track name (the track 
information area turns light grey). 

 You select the target tracks for insert and overlay editing by moving the V and A1 
tabs to the intended track, the tracks MUST be active.  

 V will only show when you have an image in the source window. 

 Usually there are initally 3 video tracks and 3 stereo (called ‘standard’) audio 
tracks. 

 More tracks can be added by right clicking in the track name area of this window and 
selecting the tracks to add. 

 It is imortant to be organised when editing and keep similar items on the same 
timeline. 

 A practical way of working is shown below : 
 
 

V4    Captions 

V3   Background pictures  

V2  Background pictures   

V1 Interview pictures    

A1 Interview sound    

A2  Background sound   

A3   Voice Over 1  

A4    Interviewee 
voice 

 

 
 

 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 A track can be locked so that the audio or video of a clip can be deleted or altered 
without affecting the other part. 

 Check that the track sync lock symbol on the video and audiotracks are selected. 

 
 

 This symbol is the SNAP tool   .  
If it is switched on, when you move, or 
drag and drop clips, it makes the clip 
‘snap’ to the edit point. Usually it is best to 
keep the snap tool ‘on’ and only switch it 
off when you specifically want to. 

 Locking a track by using the padlock 
symbol located near the track name can 
also be used to ‘protect’ the track from 
being affected by insert edits or the 
‘ripple delete’ function.  

 The locked tracks are indicated by 
slanted lines over the track area.     
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 An audio track can be muted by clicking on the loudspeaker symbol. 

 A video track can be switched off by clicking on the ‘eye’ symbol. 

 The selected sequence can be started and stopped from the timeline by using the 
spacebar.  

 
MOVING AROUND THE SEQUENCE 
 

 To move along the sequence, use the yellow scroller attached to the red line. 

 You can use the keys L and J to play the sequence forwards and backwards, 
and the K key to pause. 

 If you press L or J twice the footage will play faster. 

 Use the + and – keys to expand and reduce the sequence view. 

 The slider on the bottom of the sequence window can also be used to expand or 
reduce the size of the sequence view. 

 

 The yellow timecode numbers on the top left of the sequence indicate the exact 
position of the yellow scroller. 

 
 
FINDING A CLIP FROM YOUR SEQUENCE IN YOUR BINS 
 

 Select the clip on your sequence and right click, from the options select ‘Reveal 
in Project’. 

 The clip will be highlighted in the bin in your project window, 
 
 
 
 

You can copy and paste a picture on the time line 
using CTRL+C and CTRL+V keys 

 

You can cut and paste using  

CTRL+X and CTRL+V keys 
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THE TOOLS WINDOW 
 

 

A. Selection tool 
 

B. Ripple Edit tool 

C. Rate Stretch tool 

D. Slip tool 

E. Pen tool 

F. Hand tool 

G. Track Select tool 

H. Rolling Edit tool 

I. Razor tool 

J. Slide tool 

K. Zoom tool 

 

Selection Tool (Key V) 

 This is the tool that is used most of the time. 

 ALWAYS return to this tool after using any of the other tools. 
 
Track Select Tool (Key A) 

 Select this tool (a black arrow) to select all the clips to the right of the cursor in a 
sequence. To select a clip and all clips to the right in that track, click the clip.  

 Holding the Shift key with Track Select Tool switched on changes the Track 
Selection Tool into a MULTI-TRACK Selection Tool (two black arrows), this enables 
all tracks to the right of a selected clip to be selected. 

 If a track has been locked it cannot be selected.  

 If you use the Track Select tool, return afterwards to the Selection tool. 
 

Razor Tool   

 Select this tool to make one or more incisions in clips in the sequence. Click a point 
in a clip to split it at that precise location. To split clips in all tracks at that location, 
hold the SHIFT key down at the same time. 

 If you use the RAZOR cutting tool to cut an edit, return to the SELECTION tool 
afterwards to avoid accidentally cutting another edit. Also make sure you have the 
correct track selected for cutting. 

 
 

 If you want to cut a shot exactly where the scroller bar  

is located in the sequence use : 

CTRL+K keys 

This is the fastest and most accurate way of cutting a shot. 

Only ACTIVE tracks (pale grey) will be cut. 
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ADJUSTING AUDIO  
 
THE AUDIO MIXER 
 

 Audio for a whole track can be adjusted using the AUDIO MIXER (a tab for 
accessing this is found beside the Source Window). 

 

 
 

 Use the fader to increase or decrease the audio level across the whole track. 

 This option is mostly used for the BACKGROUND audio, as generally this will all 
need to be decreased.  
 

 It is also useful for increasing a voice track where the voice is at a low level (either 
voice over or interviews). 

 

 When playing back your programme before final output for export or to tape, have 
the Audio Mixer window up so that you can visually check that none of the sound 
levels are too high. 
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 ADJUSTING AUDIO FOR A CLIP 
 

 
 

 To adjust audio for an individual clip you need to expand the relevant audio track 
(using the small triangle by the track name). 

 If you move the mouse pointer over the yellow line on the audio track you will see it 
change shape to indicate a flat line, whilst in this form you can increase or decrease 
the audio level of that clip.  

 Hold the left button of the mouse down when altering the audio level of a clip. 

 Altering the sound level of an individual clip is still possible even if the audio mixer 
has been used to lower or raise the sound level of the whole track. 

                
ADJUSTING AUDIO USING KEY FRAMES 
 

 Audio will need to be adjusted using key frames particularly where there is an 
interview in one language and there is the translation voice on another track. 

 Ideally you should hear the interviewee talking in their language first, this then fades 
to a lower level before the translation voice is heard. 

 Two key points need to be added before the translation voice so that the level can 
be lowered. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 Select the clip.  

 Add a key point by positioning 
the scroller bar at the point for 
the key point, then click on the 
add-remove key point tab (just 
below the small triangle which 
opens and closes the track).  

 Move to the next position for the 
key point and do the same.  

 Lower the sound level for the 
clip after the two key points and 
you will see a visual 
interpretation of the sound level 
going down. 

 
 You can also create a key point by holding down the 

CONTROL key and clicking with the mouse on the 
yellow line on the audio track of a clip 
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If the translation voice is shorter than the interviewee actually speaking, you can 

enter two more key points and raise the interviewee’s voice at the end of the 
interview.  

  
ADJUSTING VIDEO  
 

EFFECT CONTROLS 
 

 There are three effects which can be altered in a video clip without adding an effect 
from the effects panel, these are: 

- MOTION 
- OPACITY 
- TIME REMAPPING 

 MOTION will be described later in the section on INSETTING A CLIP. 
 

 You may want to adjust VIDEO OPACITY for an individual clip to make it darker so 
that you can use it as a background for captions.  

 Expand the relevant video track (using the small triangle by the track name). 

 If you move the mouse pointer over the yellow line on the video track you will see it 
change shape to indicate a flat line, whilst in this format you can alter the opacity 
level of the clip. 

 Hold the left button of the mouse down when altering the opacity level of a clip. 
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TIME REMAPPING is an advanced feature and is rarely used. 
 
 

APPLYING A VIDEO or AUDIO TRANSITION or EFFECT 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

 By selecting the altered 
clip and then clicking on 
the EFFECTS 
CONTROL window next 
to the source window 
you will be able to see 
exactly the opacity level 
you have set.  

 You can also alter the 
level directly in this 
window. 

 

 Open the EFFECTS PANEL on the left of the Sequence 
Window. 

 Open the bins to select a transition (or effect). 

 Drag and drop the transition (or effect) on to your clip. 
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TRANSITIONS 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 To DELETE A TRANSITION, click on the transition in the clip and use the DELETE 
key. 

 
 

 If you applied a 
TRANSITION, double 
click the transition in 
the timeline and then 
go to EFFECTS 
CONTROL PANEL. 

 Tick SHOW ACTUAL 
SOURCES so you 
can see the effect with 
the actual pictures. 

 You can alter the 
transition duration and 
other parameters 
here. 
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EFFECTS 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Reset an effect by clicking the RESET symbol   on the right of the effect. 

 Switch an effect OFF by clicking the fx symbol beside the effect name. 

 DELETE an effect by clicking on the effect name and hitting the DELETE key. 
 
 

 You can COPY AND PASTE an EFFECT from one clip to another by :  

 Selecting the clip with the effect  

 Copying it (CTRL+C or right click and select COPY) 

 Go to the clip (or clips) where you want to apply the effect, select the clip 

 Right click and then select PASTE ATTRIBUTES 

 All effects from the original clip will be applied to the new clip 
 
 

AUDIO TRANSITIONS and EFFECTS  
 

 AUDIO EFFECTS AND TRANSITIONS work in similar ways, but do not usually 
have to be rendered (see next page). 

 

 If you applied an 
EFFECT, click on the clip 
where you have applied 
the effect and then go to 
the EFFECTS CONTROL 
PANEL.  

 Click on the small triangle 
to open and view the 
effect. 

 You can then adjust the 
effect (example on the left 
shows a Drop Shadow 
effect). 
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RENDERING EFFECTS AND TRANSITIONS 
 
 

 
 

 Most effects and transitions will play on the sequence, but a red area above the 
sequence indicates that this section will have to be RENDERED before the 
programme is exported as an encoded file, or recorded to tape. 

 

 To render, first select the sequence. 

 Make sure the work area bar is the same length as the sequence to be encoded 
 
 
 
    

 
 

 Now click on SEQUENCE at 
the top of the Premiere 
screen and select Render 
Effects in Work Area.   

 Or select the sequence to be 
rendered and use the 
ENTER key. 

 After rendering the red line 
will now be green at the top 
of the sequence.  
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TO SCALE A SHOT and PLACE ONE SHOT WITHIN 
ANOTHER  

 

 To scale a shot on the sequence, first decide what you want in the background when 
the picture is scaled down, the background needs to be on Video 1. 

 The shot to be scaled must be on Video 2. 

 Double click on the shot to be scaled so that it opens in the source viewer. 

 Next click on the Effect Controls tab beside the source window. 

 Click the small triangle beside Motion to see the motion options, including Scale.  

 Then click on the triangle beside Scale. 
 

 
 

 Now use the sliding scale (0.0 to 100.0) to reduce the picture size to the scale you 
want, or click on the numbers beside Scale and type the figure in direct. 

 Now go to the timeline and play the effect. Adjust as necessary. 

 The position of the scaled picture can also be changed. 
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 Move to the program viewer and select the scaled down picture by double 
clicking on it, a white line appears around the image. Move it using the mouse to 
the position you want. Now play the effect on the sequence.  

 Having the SAFE MARGINS icon selected will make sure 
the inset picture is not too near the edge of frame. 



 

54 | P a g e  

 DROP SHADOW 
 

 Next to make the inset picture look good and separate it from the background 
you can add a DROP SHADOW (see also Page 23). 
 

 From the EFFECTS PANEL select :  

 VIDEO EFFECTS > PERSPECTIVE > DROP SHADOW 
 

 Select the drop shadow effect and drag it on to the clip in the 
sequence. 

 

 Go to the EFFECT CONTROLS PANEL and alter the drop shadow as 
you want. 
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BEVEL EDGES 
 
 

 If you want to make the inset picture stand out from the background, another easy 
way is to use BEVEL EDGES. 

 From the EFFECTS PANEL select :  

 VIDEO EFFECTS > PERSPECTIVE > BEVEL EDGES 
 

 
 
 

 
 
 
 
 
 

 

  

 Pick up this effect and 
drag it on to the clip on 
the sequence. 

 

 Go to the EFFECT 
CONTROLS PANEL 
and alter the bevel 
edges as you want. 
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 It is possible to combine the effects of bevel edges and drop shadow. 

 You can apply a fade up on the clip as well if you want. 

 Don’t forget to render the effect and save your project. 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

REMEMBER: 

 

YOU CAN DELETE ANY EFFECT FROM THE EFFECT CONTROL WINDOW BY 
CLICKING ON THE EFFECT NAME AND THEN USING THE DELETE KEY. 

 

YOU CAN SWITCH OFF AN EFFECT TEMPORARILY BY CLICKING 

ON THE fx SYMBOL TO THE LEFT OF EACH EFFECT NAME. 
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TO CREATE A STILL FRAME 
 
 

 Select the clip on the sequence that you want to make as a still frame. 

 Right click and select:  FRAME HOLD 
 
 

 
 

 
 

 In the Frame Hold Options Window, tick the HOLD ON box:  
- You can select to hold on In Point, Out Point or a Marker, the most usual 

would be IN POINT 
 

 
 

 Click on OK 

 You will usually have to render the still frame. 
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TO CHANGE THE SPEED OF A CLIP and REVERSE PLAY A 
CLIP 
 
 

 One method to change the speed of a clip is to select an IN and OUT point on 
the sequence, and ALSO an IN and OUT point on the clip. 

 When you click on OVERWRITE a window appears, select the top option :  
Change Clip Speed (Fit to Fill) 

 
 

 
 

 

 Click on OK 

 You will have to render the effect. 
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 An alternative method is to select the clip on the sequence, right click with the 
mouse and select : SPEED / DURATION 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 From the Clip Speed / Duration window you can alter the speed of the clip, or 
even make it play in reverse. 
 
 
 

 

  
 Selecting MAINTAIN AUDIO PITCH 

in this window means the audio will 
play at normal speed even if the 
video speed or direction is altered. 
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IMPORTING A GRAPHIC 

 Select the bin you want to import the graphic into. 

 Right click, select IMPORT and import the file you need. 

 Many different formats of file can be imported. 

 Once imported, double click the imported graphic and it will open in the source 
viewer (layered Photoshop files will work differently). 

 Position the image on the timeline. 

 You will probably need to alter the SIZE of the image on the sequence. The size is 
altered exactly like altering the size of any other clip. 

 

 If you are importing a still photograph or graphic which is very large, the editing 
software may not work properly, if this happens, resize the pictures/graphics 
before importing. 

 

 You can use the PAINT programme on your computer to resize an image (reduce 
the number of pixels). 

  

 
 
 
 
 
 
 

 

Note that the PIXEL size for 

PAL 4:3 (standard) format is:  720x576 

PAL 16:9 (widescreen) format is:  1024 x 576 

PAL HD format is:   1920x1080 or 1280x720 
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HOW TO CREATE A SUB-SEQUENCE or ‘NEST’  
 

 If you want to insert a number of images, like below, it is easier to create this in a 
different sequence. 
 

 
 

 If you want the timing of the photos to be accurate to the voice, select the voice and 
images, right click, select ‘NEST. The area selected is shown as green area on the 
sequence. 

 In your project window you will see a sequence called ‘Nested Sequence’, move this 
into your sequence bin. 

 Open the ‘nested’ sequence and adjust your timings and images on this sequence.  

 Any alterations will be you make in this nested sequence will also be changed on 
your main edit sequence.
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CROPPING  
 

 If certain photographs or video clips need to be cropped, first select the clip in the 
sequence. Then go to the Effects Window and select : 

 

Video Effects > Transformation > Cropping 
 

 Drag and drop the effect onto the clip or picture to be cropped. 

 Double click on the clip to open it in the Source Viewer. 

 Select Effect Controls 

 Click on the small triangle next to Cropping and you can crop the clip. 
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TITLES and CAPTIONS in English 
  

 There is a specific titling /captioning programme within Premiere, for certain 
languages you must ensure that the necessary fonts are installed on your computer. 

 Before creating a caption, on your sequence, place the yellow scroller bar at the 
point where you want the caption to appear. 

 Go to the Project Window and create or select the CAPTION BIN. 

 Go to: FILE > NEW > TITLE      (or select the New Item icon and choose Title) 
 
 
 
 
 
 
 
 
 
 
 

 
 

 There are two thin lines in the Titling window: 
- the area outside the outer line is the CUT-OFF AREA and may not be seen if the 

video is shown on domestic televisions. 
- captions need to be placed within the TITLE-SAFE area (inside the inner line) to 

be certain they can be read and they will not be ‘cut-off’ or be on the very edge of 
frame. 

 

 A NEW TITLE window will appear. 

 Enter the NAME for the caption you are creating, click 
OK. 

 The CAPTION (TITLE) WINDOW will open with the 
background picture from the sequence. 

 If the background picture does not appear, click on the 
‘Show Background Video’ button  
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 Captions can either be created using the TITLE STYLES below the monitor window, 
the TOOLS on the left of the monitor window, and TITLE PROPERTIES on the right, 
or you can create them yourself. 

 

 Every caption can be easily altered and resized as in most graphics programs. 
 

 There are a large number of TEMPLATE styles of titles and captions which can be 
adapted for your programme. 

 To access the templates go to the symbol shown bottom right of these three 
symbols. 
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 Once your title or caption has been created, close the Title window (you do not 
‘save’ as this is done automatically). 

 The caption will appear in your CAPTION BIN. 
 

 Drag the caption down onto the sequence and then place it on the video track for 
captions (usually Video Track 3). 

 
 
  

 One of the most useful 
selections is in the folder 
for LOWER THIRD 
CAPTIONS. 

 

 The duration can be altered by 
stretching the caption along 
the timeline. 

 TRANSITIONS can be applied 
to the caption like any other 
clip. 
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 Name captions are created the same way, you need the caption to last a minimum 

of 4 seconds plus the fade up and fade down.
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To Create Another Caption by Altering an Existing One 
 

 To create another caption by altering an existing one, go to the bin, select the 
caption you want to alter, right click and select duplicate, give the duplicate caption 
a new name. 

 Double click the newly named caption and then alter it within the Title Window. 

 If you do not duplicate the caption first, then you will be altering the caption on 
the sequence that you have already prepared. 

 
 
To Export and Save a Caption for Use in Future Projects 
 

 To export and save the caption for importing into future projects select the caption to 
export. 

 Go to FILE > EXPORT > TITLE 

 In the export window create a folder to save the captions into (TITLES and 
CAPTIONS), make sure the name of the file you save is the same as the caption, 
then click SAVE. 

 Your caption or title will be saved into the folder in a format which it can then be 
opened in another project. 

 It is sensible to do this for ALL the captions you create for your project. 
 
  

 

NOTE 
 

If you double click on a title or caption from within the sequence or bin,  

it will open in the Titling Window 
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TITLES and CAPTIONS in Arabic  
 

 Arabic and similar texts cannot be written direct in Titler as the software 
automatically reverses the text from Right to Left to Left to Right. 

 There are three options for producing Arabic texts. 
 
1. A VERY useful website 

http://www.arabic-keyboard.org/photoshop-arabic/ 

 
Type or copy the Arabic text into the main box, then click on Copy’, the text is 
converted and copied to clipboard. 

 
You can now go into Titler and paste the text in - the text will be correctly reversed to 
the correct way of Right to Left. 
 
This means that you have the full facility of Titler available. 

 
  

http://www.arabic-keyboard.org/photoshop-arabic/
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2. When using Photoshop (non ME version) 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Ensure that the programme is set up for 
Arabic text. 

 In CS6, go to your Preferences and select 
Type.  

 Then, under Text Engine Options, select 
Middle Eastern.  

 Now relaunch Photoshop for the change to 
take effect.  

 Once Photoshop is relaunched, select: 
 
Type Menu > Language Options > Middle 
Eastern Features  

 

 The Character and Paragraph panels will 
have lengthened with new icons to support 
Arabic text features. 

 

https://d37wxxhohlp07s.cloudfront.net/s3_images/733316/r2l.jpg?1335995842
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3. When using Photoshop Elements 

 

 You cannot type Arabic text directly into Photoshop Elements. 

 Download the PSD template from : 
 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4107      
 

 Open this file in Photoshop Elements and copy and paste Arabic text into the 
document as needed (this can be from a text file or pdf). 

 Remember to save the file (with a different name) in the Project Folder on the D 
drive. 

 Now import this file into Premiere. 

 An area behind the caption can be created with a Colour Matte or from Titler. 
 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4107
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EXPORTING FILES for TRANSCRIPTIONS and TRANSLATIONS 
 

 Have the relevant sequence open in the sequence window with each answer as a 
separate clip and 5 seconds black inbetween. 

 If necessary, lower or increase the audio level using the audio mixer. 

 Make sure the correct Sequence is selected (it will have a yellow line around it).  

 Before exporting the sequence, go to the Effects Window : 
From Video Effects, open Video and select : Timecode  

 Drag and drop this effect on the first clip in the interview sequence interview. 
 

 
 

 Open the effect in the Effect Controls window.  

 Click on the small triangle next to Timecode and select : 
Format :     SMPTE 
Timecode Source :   Media (this is very important !) 
Time Display :     25 (this is very important !) 

 The clip in the sequence now shows the numbers from the timecode of the original 
tape. 

 Now alter the SIZE of the timecode numbers (so that they will be easy to read) : 
- Click on the small triangle beside Size 
- Use the sliding scale to alter the size of the numbers so they can be read 

easily  
 

 Copy this effect on to all the clips in the sequence. 

 Use COPY (CTRL+C) and then PASTE ATTRIBUTES : 

 To copy, select the clip and then right click and select COPY.  

 Go to the clip you want to apply the effect to, or select all the clips. 

 Right click and select PASTE ATTRIBUTES. 

 All the clips in the sequence should now show the original timecode recorded. 

 If you are working in a language you do not understand, you can use the 
timecode to identify exact points in the interview with the person who has 
transcribed and translated the interview.  
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 Now render each interview sequence (the red line will turn green). 

 Now select the each sequence and go to :  
FILE > EXPORT > MEDIA 

 The Export Settings window opens.In Export Settings: 
 

 
 
 

 For Format:            select a useful format, e.g. Windows Media or FLV 

 For Preconfiguration :   select a useful preconfiguration  
e.g. PAL Half or PAL DV Widescreen 

 For Output Name : click on the yellow output name and create or select the folder 
you want to save the file to (by default the file name will be the same as the 
sequence name) 

 

 Now click EXPORT at the bottom of the Export Settings window. 

 The sequence will now be encoded. 
 

 IF you have a number of files to export, click on Queue instead of Export. 
 

Adobe Media Encoder will now open. 
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ADOBE MEDIA ENCODER 
 

 If you have forgotten to save the file to a particular folder, or to give it the file name 
you want then you can still do this by clicking on the Output File. 

 

 
 

 Now return to Premiere and select a new sequence to export, repeat the same 
actions. 

 Now when you go to Adobe Media Encoder, 
you will find another file to encode. 
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 The sequences you have 

selected will now encode. 
 

 A green ‘tick’ will apear next to 
the file name when it has 
encoded. 

 

 When you are ready, click the small green 
triangle top right of the encoder screen. 
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HOW TO EXPORT A SEQUENCE 
 

 Open and select the sequence you want to export. 

 Before encoding a programme, make sure you have played through the programme 
and are certain that the sound levels are balanced (MAXIMUM levels should be -
6db, voice levels should ideally be between -12db and -6db). For the balance of the 
audio channels, make sure you are listening on headphones, it is not good 
enough to only listen on speakers.  

 Ensure that the grey work area bar covers the whole of the programme, this is the 
bar with yellow ends immediately above the top video track. 
 

 
 

 Complete all renders (SEQUENCE > RENDER EFFECTS IN WORK AREA and to 
be safe also RENDER AUDIO). 

 You can also select the sequence to be rendered and use the ENTER key. 
 

 Select the sequence, then select : FILE >  EXPORT > MEDIA 

 The Export Settings window will open. 
 

 Now make your selections for file format and preconfiguration as necessary.  
 

 If you want to encode more than one sequence, use Adobe Media Encoder as 
described previously. 
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RECORDING TO DIGITAL TAPE  
 

 Before recording a programme to digital tape, make sure you have played through 
the programme and are certain that the sound levels are good (MAXIMUM levels 
should be  
-6db, voice levels should ideally be between -12db and -6db.  

 Also ensure that all renders have been completed. 
 

 Before connecting the camera for outputting the tape, insert the tape to record on to 
and record a minimum of 30 seconds of COLOUR BARS. 

 You do not want sound recorded on this, so plug in the external microphone but do 
not switch it on. 
 

 Now put the camera into to PLAY/EDIT mode. 

 Connect the camera with the Firewire cable. 
- It is ALWAYS better to connect the camera BEFORE going in to Premiere Pro 

 Always have the camera running from mains when editing (preferably through a 
UPS)  

 Now go into your project in Premiere. 
 

 Go to the PROJECT WINDOW, right click and select  
New Item > Bars and Tone and then New Item > Video Black.   
OR FILE > NEW > BARS AND TONE  for Colour Bars and Tone 

FILE > NEW > BLACK VIDEO   for Black 
 

 
 
 

 In the window that opens, select :  
        D1/DV PAL Widescreen 

16:9 
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 The duration of Bars and Tone and the 
Video Black can be changed by right clicking 
item in the bin, select Speed / Duration and 
then type the number of minutes and seconds 
as necessary. 

 This example shows a duration of 1 
minute. 
 
 
 
 

 Create a NEW SEQUENCE in your sequence bin, name it as PLAYOUT.  

 Open the Playout sequence in the Sequence Window. 

 Place 60 seconds of COLOUR BARS on this timeline followed by 30 seconds of 
BLACK. 

 Now drag and drop your EDITED SEQUENCE from the Sequence Bin onto the 
Playout Sequence – your edited sequence is ‘NESTED’ within the Playout 
Sequence. 

 Now place 1 minute of BLACK at the END of the programme. 
. 
 

 
 

 The colour bars and tone are used for checking video and audio levels when making 
VHS copies of the programme.  

 The black at the start is used to give a run-in to the programme and the black at the 
end provides a clean signal after the programme has finished. 

 Make sure the work area bar covers the whole length of the programme 

 Now go to:  Sequence > Render Effects in Work Area  

 Also render the audio : Sequence > Render Audio 
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BEFORE RECORDING ONTO TAPE…. 
 

 Ensure the video recorder is connected through the firewire cable. 
 

 Check :  PREMIERE PRO > PREFERENCES > DEVICE CONTROL  
Click on OPTIONS and ensure Video Standard is selected for PAL 
Device Brand can be selected as necessary 
Click OK when finished 
 
 

 Then select : PREMIERE PRO > PREFERENCES > PLAYBACK 
 

 
 

Audio Device : select Adobe DV 
Video Device : select Adobe DV 
Also select : Disable video output when in the background 

 

 Click on OK. 
 

 

 After, select the correct Playout sequence in the sequence window.  
 

 Now select: FILE > EXPORT > TAPE 
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ALWAYS make sure you have  
TWO COPIES OF A MASTER PROGRAMME 

(this is your ‘insurance’!) 

 

 From this window select: 
- ACTIVATE RECORDING 

DECK 
 

 Ensure the OPTIONS are 
selected 
 

 Now press the Record option 
and the computer will take 
over! 

 

 After finishing the recording, return to: 
EDIT > PREFERENCES > PLAYBACK 

 

Return the selections to the original settings 
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MAKING MULTIPLE LANGUAGE VERSIONS of your 
PROGRAMME 
 

 Before a new language version can be made, your programme must be translated 
accurately into the new language.  

 Check your final script against the programme and make sure that the words on the 
script are accurate. 

 TIME each section (shot) of voice, this timing should be noted on the script. 

 It is best to make the script into a landscape format so that an extra column can be 
added for the translation, for example… 
 

Script 02: Seed Sorting by Flotation 

Draft: FINAL  Duration:   06’50”  Word Count: 760  Date: June 30 2009 

 
 

Shot Video Audio English 
 

Audio LOCAL Duration 

1 Title Caption: 
Seed Sorting By 
Flotation 
 

   

2 Clean seed sample Improving the quality of farmers’ seed is very 
important for Bangladesh because more than 
95% of the farmers use their own seed.  
 
But if you want a good yield, you must start 
with healthy seed. 
 

 18” 

3 Sample with insect Farmer-saved seed is generally of poor quality 
because of contamination, mostly from insects 
and diseases. 
 
Seed damaged by insects or unripe seeds are 
much lighter than healthy seed so it is easy to 
get rid of these light seeds. 
 

 20” 

4  Let’s have a look at how women in Maria 
village, near Bogra in Bangladesh, use a 
method called the seed flotation technique to 
improve their seed quality. 
 
 

 12” 

 

 If possible the translation of the script should be done on computer, but there are 
times where the translation will have to be handwritten. 

 Finding GOOD people to translate the programme accurately and then record the 
voice over in the new language is not easy. It is not worth taking shortcuts. 

 Before recording, always check the translation of the programme with colleagues. 

 The timings that have been noted for each shot are very important when the voice 
is recorded, so that you can be certain the new voice will be the same duration. 

 If possible, record the voice in a proper sound studio, where the timings can be 
easily checked, otherwise make sure someone is timing the recordings.  
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 If possible, record the audio files as 48 KHz 16 bit WAV files, as this is the format for 
digital video. 

 44.1 KHz or MP3 audio files are also useable. 
 
The audio file(s) of the new voice are first transferred into the editing computer.  

 Make sure you put them in a folder WTIHIN your project folder.  

 Import them into Premiere Pro: either as the whole folder or into a bin you have 
created. 

 

 Before starting to make another language version of your programme, first 
DUPLICATE the final edited sequence. Select the sequence in the Sequence Bin, 
right click, select duplicate, now give this version of the programme a new name (the 
new language). 

 Double click this new sequence to open it the sequence window. 

 Lock the video and audio tracks (see Page 20). The aim is always to keep the 
programme the same length. 
 

 
 

 Add a new audio track (see Page 20). The new audio files can then be placed on 
this track.  

 Use the original voice track (usually in English or French) as your guide for placing 
the new voice files in the correct position. 

 Once the new voice files are in the correct position, you can MUTE the guide track 
(see Page 20). 
 

 Now check the audio levels of the new voice in relation to the programme.  
USE HEADPHONES!!! 

 It is best to use the audio mixer to raise or lower the levels if necessary. Remember 
you can alter the audio level within an individual clip as well (see page 24). 

 

 If during an interview, the interviewee was talking in the new language, then 
obviously this does not need translating, but the sound level for the interviewee must 
be brought up to normal levels so that people can clearly hear what they are saying 
(you will have to unlock the relevant audio track to do this). 
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Once all the new audio is in the correct place, and all audio levels have been 
checked and adjusted, then this new programme can be exported or recorded onto 
tape. 
 

Why keep the translated programme the same length? 
 

 When you are making multiple translations of programmes it is easier and less work 
if the programme is kept the same length. 

 If a multiple programme / multiple language DVD is being made of the programme, 
the aim is to keep the visual element of the DVD the same, and only the audio tracks 
change.  
This means that more programmes can be put on one DVD, therefore saving on 
duplication costs. 

 
 
Captions… 
 

 Changing captions is generally not needed. 

 If you want or need to change captions into this new language, first make sure you 
have all the captions correctly translated (and spelt). 

 DO NOT just change the captions that are on the new timeline as you will be 
changing them in the original programme, you must first duplicate them and then 
alter them (see page 42). 

 Then place the new captions either to replace the original ones, or on a new video 
track – and then ‘switch off’ the original caption track (see page 20).  
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ARCHIVING YOUR PROJECT 
 

 
When you have finished the project you are working on, make sure you archive your 
project so that you can recreate it if necessary at any point in the future. 
 
Your working folder should contain ALL files that have been used in the programme: 

 The Premiere Project file 

 All footage 

 Voice files 

 Music 

 Any graphics or photographs 
 

 
Archive the files onto a separate hard drive – always use more than one in case a 
hard drive fails. 

 
 
 

 

USEFUL WEBSITES 

 
www.adobe.com/support/contact   
 
www.forums.adobe.com/community/premiere  
 
http://premierepro.wikia.com/wiki/Adobe_Premiere_Pro_Wiki 
 
www.creativecow.net  (forums, blogs, training, tutorials) 
 
www.dvinfo.net  (forums, blogs, training, tutorials) 
 
www.larryjordan.biz  (forums, blogs, training, tutorials) 
 
www.lynda.com  (training, tutorials) 
 

 
  

http://www.adobe.com/support/contact
http://www.forums.adobe.com/community/premiere
http://premierepro.wikia.com/wiki/Adobe_Premiere_Pro_Wiki
http://www.creativecow.net/
http://www.dvinfo.net/
http://www.larryjordan.biz/
http://www.lynda.com/
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